Thank You for Choosing Ross

You've made a great choice. We expect you will be very happy with your purchase of Ross Technology.

Our mission is to:

1. Provide a Superior Customer Experience
   • offer the best product quality and support
2. Make Cool Practical Technology
   • develop great products that customers love

Ross has become well known for the Ross Video Code of Ethics. It guides our interactions and empowers our employees. I hope you enjoy reading it below.

If anything at all with your Ross experience does not live up to your expectations be sure to reach out to us at solutions@rossvideo.com.

David Ross
CEO, Ross Video
dross@rossvideo.com

Ross Video Code of Ethics

Any company is the sum total of the people that make things happen. At Ross, our employees are a special group. Our employees truly care about doing a great job and delivering a high quality customer experience every day. This code of ethics hangs on the wall of all Ross Video locations to guide our behavior:

1. We will always act in our customers’ best interest.
2. We will do our best to understand our customers’ requirements.
3. We will not ship crap.
4. We will be great to work with.
5. We will do something extra for our customers, as an apology, when something big goes wrong and it's our fault.
6. We will keep our promises.
7. We will treat the competition with respect.
8. We will cooperate with and help other friendly companies.
9. We will go above and beyond in times of crisis. If there's no one to authorize the required action in times of company or customer crisis - do what you know in your heart is right. (You may rent helicopters if necessary.)
communications. Operation of this equipment in a residential area is likely to cause harmful interference in which case the user will be required to correct the interference at his own expense.

Canada

This Class A device complies with Canadian ICES-003 and part 15 of the FCC Rules.

Cet appareil numérique de la classe “A” est conforme à la norme NMB-003 du Canada.

**Notice** — Changes or modifications to this equipment not expressly approved by Ross Video Ltd. could void the user's authority to operate this equipment.

European Union

This equipment is in compliance with the essential requirements and other relevant provisions established under regulation (EC) No 765/2008 and Decision No 768/2008/EC referred to as the “New Legislative Framework”.

**Warning** — This equipment is compliant with Class A of CISPR 32. In a residential environment this equipment may cause radio interference.

Australia/New Zealand

This equipment is in compliance with the provisions established under the Radiocommunications Act 1992 and Radiocommunications Labeling (Electromagnetic Compatibility) Notice 2008.

International

This equipment has been tested under the requirements of CISPR 22:2008 or CISPR 32:2015 and found to comply with the limits for a Class A Digital device.

**Notice** — This is a Class A product. In domestic environments, this product may cause radio interference, in which case the user may have to take adequate measures.

Environmental Information

The equipment may contain hazardous substances that could impact health and the environment.

To avoid the potential release of those substances into the environment and to diminish the need for the extraction of natural resources, Ross Video encourages you to use the appropriate take-back systems. These systems will reuse or recycle most of the materials from your end-of-life equipment in an environmentally friendly and health conscious manner.

The crossed-out wheeled bin symbol invites you to use these systems.

If you need more information on the collection, reuse, and recycling systems, please contact your local or regional waste administration. You can also contact Ross Video for more information on the environmental performances of our products.
Company Address

Ross Video Limited
8 John Street
Iroquois, Ontario, K0E 1K0
Canada

Ross Video Incorporated
P.O. Box 880
Ogdensburg, New York
USA 13669-0880

General Business Office: (+1) 613 • 652 • 4886
Fax: (+1) 613 • 652 • 4425
Technical Support: (+1) 613 • 652 • 4886
After Hours Emergency: (+1) 613 • 349 • 0006
E-mail (Technical Support): techsupport@rossvideo.com
E-mail (General Information): solutions@rossvideo.com
Website: http://www.rossvideo.com
## Contents

### Introduction
- Related Publications ................................................................. 9
- Documentation Conventions ...................................................... 9
- Interface Elements ........................................................................ 9
- User Entered Text ........................................................................ 9
- Referenced Guides ........................................................................ 9
- Menu Sequences ........................................................................... 10
- Important Instructions ................................................................. 10
- Contacting Technical Support ....................................................... 10

### Before You Begin
- Overview ..................................................................................... 11
- Features ....................................................................................... 11
- Control Panel Overview .............................................................. 12
- Physical Connections .................................................................... 13
- Interfaces Overview ..................................................................... 14
  - Configuration Interface .......................................................... 14
  - Active Channel On Air Control Interface ................................ 15

### Physical Installation
- Before You Begin ....................................................................... 17
- Static Discharge ........................................................................... 17
- Unpacking .................................................................................... 17
- Related Publications ................................................................... 17
- Getting Started ........................................................................... 17
- Installing the MC1-MK Cards Overview ....................................... 18
- Ethernet Cabling ......................................................................... 19
  - Ethernet Cabling for the MC1-PANEL-16 ................................ 19
  - Setting the DIP Switches .......................................................... 20
    - SW1, SW2 — IP Address Setup ........................................... 20
    - SW3 ....................................................................................... 20
    - SW4 — Bootload Method ...................................................... 21
- Power Connections ...................................................................... 21
  - Power Supply Connectors (PS1, PS2) ....................................... 21
  - Power Cable Connection .......................................................... 21
  - Control Panel Button Inserts .................................................. 22

### Using DashBoard
- Navigating to the Configuration Interface ................................ 23

### Configuration
- Before You Begin ....................................................................... 25
- Configuring the Ethernet Communications ............................... 25
  - Initial Setup ............................................................................. 25
  - Troubleshooting ....................................................................... 26
- Custom User Configuration via DashBoard ................................ 26
- Automatic Configuration using DHCP ........................................ 27
- Preset Configuration using the DIP Switches ............................... 27
- MC1-PANEL-16 Personality ........................................................ 28
  - Setting the Panel Name ............................................................ 28
  - Configuring the Edit Permissions ............................................. 29
  - Configuring the Power Supply Alarms ..................................... 29

---

**MC1-PANEL-16 User Guide (v4.0)**

**Contents**
Mnemonic Display ................................................................. 29
LCD Display ........................................................................ 30
Loading the Factory Defaults .................................................. 30
   To reset the card to the factory default settings in DashBoard ............ 30
Assigning an MC1-MK Card to a Channel Button ...................... 30
Configuring the Channel Personality ......................................... 31
Specifying the Number of Available Crosspoints ...................... 31
Displaying the On Air Control Interface .................................. 32
Disabling the Fade to Black Button ....................................... 32
Color Schemes ....................................................................... 33

Operation 35
Active Channel On Air Control Interface .................................. 35
Troubleshooting .................................................................... 35
Selecting a Master Control Channel ......................................... 36
Channel Ganging .................................................................... 37
Transitions ............................................................................ 37
   Performing Transitions ..................................................... 39
   Transition Notes ............................................................... 39
SqueezeBack Effects ............................................................... 39
   Performing Transitions with SqueezeBack Presets ................. 40
   Previewing a Squeeze Effect ............................................. 41
Transitions with SqueezeBack ................................................. 41
   Basic Transition with a Squeeze Effect ............................... 41
   Dissolve to a Static Squeeze Effect ................................... 41
Keying .................................................................................. 41
   Overview ......................................................................... 42
Audio .................................................................................. 42
   Setting the Master Audio Level ....................................... 43
   Performing Transitions .................................................. 43
   Voice Overs .................................................................. 43
      Including a Voice Over ............................................... 44

Software Upgrades 45

DashBoard Menus 47
Status Tabs ........................................................................... 47
   Hardware Tab ................................................................. 47
   Product Tab ................................................................... 48
   Ethernet Tab .................................................................. 48
Panel Name, Permission Tab .................................................. 49
Channel, Mnemonic, LCD Tab ............................................... 50
Alarm Enables Tab .................................................................. 51
Load/Save Tab ...................................................................... 51

Technical Specifications 53
Environment .......................................................................... 53
Input Voltage ......................................................................... 53
Power .................................................................................. 53

Service Information 55
Troubleshooting Checklist ..................................................... 55
   Software Upgrades ......................................................... 55
   Warranty and Repair Policy ............................................. 55

Glossary 57

MC1-PANEL-16 User Guide (v4.0)
Introduction

This guide covers the installation and configuration of the MC1-PANEL-16. The following chapters are included:

• “Introduction” summarizes the guide and provides important terms, and conventions.
• “Before You Begin” provides general information to keep in mind before installing and configuring your MC1-PANEL-16. It also provides a basic introduction to the hardware features including the cabling and monitoring features of the panel.
• “Physical Installation” provides instructions for the physical installation of the MC1-PANEL-16.
• “Using DashBoard” outlines how to display the MC1-PANEL-16 interfaces in the DashBoard window.
• “Configuration” provides instructions for configuring the MC1-PANEL-16 using the options available in DashBoard.
• “Operation” provides a summary of the operational features of the MC1-PANEL-16.
• “Software Upgrades” outlines how to upgrade the MC1-PANEL-16 via DashBoard.
• “DashBoard Menus” summarizes the menus and parameters of the card tabs in DashBoard.
• “Technical Specifications” provides information on the specifications for your MC1-PANEL-16.
• “Service Information” provides information on the warranty and repair policy for your panel.
• “Glossary” provides a list of terms used throughout this guide.

Related Publications

It is recommended to consult the following Ross documentation before installing and configuring your MC1-PANEL-16:

• **DashBoard User Manual**, Ross Part Number: 8351DR-004
• **MC1-MK Installation Guide**, Ross Part Number: MC1MKDR-004
• **MC1-MK Operation Guide**, Ross Part Number: MC1MKDR-004B
• **MC1-DB-CLN Quick Start Guide**, Ross Part Number: MC1DBCLNDR-002
• **MC1-PANEL-16 Quick Start Guide**, Ross Part Number: 8800DR-200
• **MC1-PANEL-16 Desk Mounting Guide**, Ross Part Number: 8800DR-302

Documentation Conventions

Special text formats are used in this guide to identify parts of the user interface, text that a user must enter, or a sequence of menus and sub-menus that must be followed to reach a particular command.

**Interface Elements**

Bold text is used to identify a user interface element such as a dialog box, menu item, or button. For example:

In the **Network** tab, click **Apply**.

**User Entered Text**

Courier text is used to identify text that a user must enter. For example:

In the **Language** box, enter **English**.

**Referenced Guides**

Text set in bold and italic represent the titles of referenced guides, manuals, or documents. For example:
For more information, refer to the *DashBoard User Manual*.

**Menu Sequences**

Menu arrows are used in procedures to identify a sequence of menu items that you must follow. For example, if a step reads “**File > Save As**,” you would click the **File** menu and then click **Save As**.

**Important Instructions**

Star icons are used to identify important instructions or features. For example:

⭐ Contact your IT department before connecting to your facility network to ensure that there are no conflicts. They will provide you with an appropriate value for the IP Address, Subnet Mask, and Gateway for your device.

**Contacting Technical Support**

At Ross Video, we take pride in the quality of our products, but if problems occur, help is as close as the nearest telephone.

Our 24-hour Hot Line service ensures you have access to technical expertise around the clock. After-sales service and technical support is provided directly by Ross Video personnel. During business hours (Eastern Time), technical support personnel are available by telephone. After hours and on weekends, a direct emergency technical support phone line is available. If the technical support person who is on call does not answer this line immediately, a voice message can be left and the call will be returned shortly. This team of highly trained staff is available to react to any problem and to do whatever is necessary to ensure customer satisfaction.

- **Technical Support**: (+1) 613-652-4886
- **After Hours Emergency**: (+1) 613-349-0006
- **E-mail**: techsupport@rossvideo.com
- **Website**: http://www.rossvideo.com
Before You Begin

This chapter provides a basic introduction to the MC1-PANEL-16, including an overview of the different areas of the control panel, and the DashBoard interfaces.

Overview

The MC1-PANEL-16 is a stand-alone control panel that provides all the basic user input for the MC1-MK card (channel) it is controlling. Up to 10 channels can be configured independently, allowing a single MC1-PANEL-16 to communicate and control 10 cards.

Features

The MC1-PANEL-16 includes the following features:

- Displays at all times: effect selection, active channel name, and program audio gain
- the MC1-PANEL-16 remembers which MC1-MK cards it was connected to before a power down
- uses redundant external power bricks
- enables a user to fully operate a Master Control system without using DashBoard
- ability to specify a glow scheme for each channel
- 1 year transferable warranty
Control Panel Overview

This section provides a basic introduction to the MC1-PANEL-16, including an overview of the different areas on the control panel.

![MC1-PANEL-16 — Top View](image)

**Figure 2.2 MC1-PANEL-16 — Top View**

1) Channel Selection Buttons 3) Display Area with Audio Gain Control 5) Keyer Area
2) Panel Control Buttons 4) Crosspoint Buses 6) Transition Area

### 1. Channel Selection Buttons

This area includes mnemonic buttons that allow you to toggle between multiple MC1-MK cards. Selecting a button enables the MC1-PANEL-16 to control the selected MC1-MK card (assigned to the corresponding channel) and displays its On Air Control interface in DashBoard.

- A lit orange button indicates that the channel is configured and available.
- A lit green button indicates the channel is selected and is active (on-air).
- A flashing green button with no other channel buttons lit indicates a loss of communication to the MC1-PANEL-16.
- A flashing green button with other channel buttons lit orange indicates a loss of communication with the MC1-MK card assigned to that channel. Verify that the Network Controller card housed in the same frame as the MC1-MK card is functioning correctly.

You can quickly verify the IP address of the MC1-PANEL-16 by pressing and holding the active Channel Select button. The IP address of the panel is reported in the Display Area.

### 2. Panel Control Buttons

This area includes buttons for enabling automation, and selecting a SqueezeBack preset.

- **AUTO ON** Button — Toggling this button on (button will be lit in the On Air Color) allows an Automation System to control the MC1-PANEL-16. If this button is toggled off, the button is lit in the Panel Button Color. Refer to the section “Color Schemes” on page 33 for details on selecting button colors.
- **EFFECT SEL** Button — Use this button to specify the SqueezeBack preset. Refer to the section “SqueezeBack Effects” on page 39 for details.

### 3. Display Area with Audio Gain Control

The vacuum fluorescent display reports the channel connection status, IP connection status, the SqueezeBack effect preset selected, and the current audio gain setting. The knob is used to control the Program audio gain, it is set by default to 0 and has a range of -72 to +12dB. Press the knob to reset the audio gain to 0dB. You can also
configure an option in the **Personality** tab of each MC1-MK card to automatically reset the audio gain to 0dB after any Background transition.

4. **Crosspoint Buses**

This area is used to select the video sources for each bus. The Preset bus is the bottom row of source buttons and selects the video source that will be taken on-air with the next background transition. The Program bus is the top row of source buttons and selects the video source that is currently on-air on the background. The mnemonic display shows the name of the source assigned to the source button directly above it.

The last button of the row is a **Shift** button, which provides access to 15 additional selectable crosspoints. Notice that when you press and hold the **Shift** button that the mnemonics also update to display the shifted bus labels.

5. **Keyer Area**

This area represents the four keyers of the channel that the MC1-PANEL-16 is controlling. Refer to the section “**Keying**” on page 11 for details.

6. **Transition Area**

This area provides the options for selecting transition rates (slow, medium, fast), and type (take, fade-fade, take-fade, mix, fade-take, and SqueezeBack). The Fade to Black (**FTB**) button is also located in this area.

**Physical Connections**

The communication ports on the MC1-PANEL-16 are used for communication. There are LAN ports for connecting to an external computer for upgrades and communicating with the openGear frame(s) that house your MC1-MK card(s). DIP switches are provided to configure the network connection of your panel.

1. **Power Supply Connections**
   a. Two power supply connections (PS1, PS2) are provided to connect external brick power supplies to the MC1-PANEL-16. Refer to the section “**Power Connections**” on page 21 for details.

2. **Ethernet Mode DIP Switches**

   Use this 4-DIP Switch block when configuring the MC1-PANEL-16 ethernet settings. Refer to the section “**Setting the DIP Switches**” on page 20 for details.

3. **Micro SD Card Slot**

   This slot is used in the case of a software upgrade failure and under the guidance of Ross Technical Support. This slot is not populated with a micro SD card when shipped from the factory.
If the MC1-PANEL-16 fails to upgrade correctly, contact Ross Technical Support for an upgrade file and instructions on using the Micro SD Card slot.

4. PMC Link Connections

There are two Panel Module Controller (PMC) Link ports are used to connect to external modules. These ports are reserved for future use.

5. Ethernet Ports

The MC1-PANEL-16 communicates over an ethernet connection to the MC1-MK cards. The Ethernet 1 port is also used for software upgrades. The Ethernet 2 port is not implemented at this time.

The exact steps for connecting to your facility via an ethernet network depends on the network requirements of your facility.

6. Reset Button

Pressing this button resets the microprocessor and re-initializes the panel. This is a hard reset of the panel. This should only be performed as advised by Ross Video Technical Support.

Interfaces Overview

In DashBoard, the MC1-PANEL-16 provides two interfaces: Configuration and Active Channel On Air Control. This section briefly summarizes each interface.

For More Information on...

• displaying the Configuration interface, refer to the section “Navigating to the Configuration Interface” on page 23.

• displaying the Active Channel On Air Control interface, refer to the section “Active Channel On Air Control Interface” on page 15.

Configuration Interface

The Configuration interface provides options for setting up and configuring your MC1-PANEL-16.

![Figure 2.4 Example of an MC1-PANEL-16 Configuration Interface](image)
From this interface you can:

- set up ethernet communications for the panel
- assign channels (MC1-MK cards) to buttons on the panel
- create a custom panel color scheme
- customize the mnemonic contrast and color
- monitor the status of the MC1-PANEL-16 hardware including power supply voltage

**Active Channel On Air Control Interface**

When a Channel button on the MC1-PANEL-16 is selected and communicating with an MC1-MK card (channel), the **Active Channel On Air Control** interface that displays in DashBoard mimics that MC1-MK card’s On Air Control interface. You must have at least one channel configured before accessing the Active Channel On Air Control interface. However, you can still operate the MC1-PANEL-16 without using DashBoard.
Physical Installation

This chapter provides additional information on physically installing your MC1-PANEL-16.

Before You Begin

Before you begin, ensure that you are using DashBoard version 6.2.0 or higher and that your MC1-MK cards are running software version 5.0 or higher.

The DashBoard Control System software and user manual are available to download from the Ross Video website.

Static Discharge

Throughout this chapter, please heed the following cautionary note:

ESD Susceptibility — Static discharge can cause serious damage to sensitive semiconductor devices. Avoid handling circuit boards in high static environments such as carpeted areas and when synthetic fiber clothing is worn. Always exercise proper grounding precautions when working on circuit boards and related equipment.

Unpacking

Unpack each unit you received from the shipping container and ensure that all items are included. If any items are missing or damaged, contact your sales representative or Ross Video directly.

Related Publications

It is recommended to consult the following Ross documentation before proceeding:

Getting Started

Each MC1-PANEL-16 can communicate with up to 10 MC1-MK cards. This section summarizes the steps you must take before you can proceed to install your MC1-PANEL-16.
Installing the MC1-MK Cards Overview

Ensure that the following tasks are performed for each MC1-MK card that the MC1-PANEL-16 will communicate with.

* Ensure that each MC1-MK card is running software version 5.0 or higher.
1. Install the openGear frame that will house the MC1-MK cards. Refer to the manual that accompanied your frame for details.

2. Install each MC1-MK card in the openGear frame as outlined in the **MC1-MK Installation Guide**.
   - **Cable the video sources** — The input video signals are connected to the rear module of each MC1-MK card in the openGear frame.
   - **Map the inputs and outputs** — The default mapping includes router inputs, but it is first necessary to configure the router outputs and crosspoints.
   - **Cable the reference source** — Connect the reference source to the rear module unless you are using the reference signal from the frame.
   - **Set up the ethernet communications** — Ensure that your card cabled and configured for ethernet communications.

3. Launch DashBoard by double-clicking its icon on your desktop.

4. Ensure that the node for each MC1-MK card is displayed in the Tree View of DashBoard. If not, consult the **MC1-MK Installation Guide** and **DashBoard User Manual**.

5. Ensure that the following tasks are performed for each MC1-MK card that the MC1-PANEL-16 will communicate with:
   - **Select the sources** — You must specify the video format and the reference source, and configure the outputs for each MC1-MK card that the MC1-PANEL-16 will interface with.
   - **Configure the SqueezeBack feature** — specifying the key order, configuring a tally/GPI for SqueezeBack.
   - **Configure the audio sources** — specify which audio group is embedded for outputs, specify how much the Program bus audio level is reduced when an EAS alert is active, specify whether the audio gain level is reset to the factory default value of 0dB during transition, configure the embedded audio sources for the Voice Over feature for audio transitions.

### Ethernet Cabling

The MC1-PANEL-16 communicates over ethernet to the MC1-MK cards. The **Ethernet 1** port on the rear of the MC1-PANEL-16 is also used for software upgrades. The exact steps for connecting to your facility via an ethernet network depends on the network requirements of your facility. Note that in addition to the **Ethernet 1** port on the MC1-PANEL-16, you must also provide an ethernet connection to the openGear frame as outlined in its manual. Set up of ethernet connections between the devices, such as a router, and the MC1-MK cards are outlined in the **MC1-MK Installation Guide**.

⭐ Ross Video strongly recommends installing your Master Control System on a network that is segregated from your facility LAN.

### Ethernet Cabling for the MC1-PANEL-16

The **Ethernet 1** port on the rear of the MC1-PANEL-16 is used to connect to an ethernet network for communications, and software upgrades using DashBoard.

Contact your IT Department before connecting to your facility network to ensure that there are no conflicts. They will provide you with an appropriate value for the IP Address, Subnet Mask, and Gateway for the MC1-PANEL-16.

You will require a standard network CAT-5 cable to connect the MC1-PANEL-16 to your facility network. (Figure 3.2) There is no need for a crossover cable as the MC1-PANEL-16 includes an Auto-MDIX ethernet PHY that will switch from straight to crossover automatically as needed. Ross Video does not supply these cables.
Setting the DIP Switches

This section briefly summarizes the DIP Switch settings on the MC1-PANEL-16. Refer to Figure 3.2 for the locations. Note that Figure 3.3 shows the DIP Switches in the UP position.

**SW1, SW2 — IP Address Setup**

**SW1** and **SW2** are used in conjunction with the DashBoard menus to set the IP Address of the MC1-PANEL-16. Refer to Table 3.1 and the card labeling for DIP Switch positions.

### Table 3.1 SW1 and SW2 Positions

<table>
<thead>
<tr>
<th>SW1</th>
<th>SW2</th>
<th>Controlled via DashBoard</th>
<th>Descriptions</th>
</tr>
</thead>
<tbody>
<tr>
<td>UP</td>
<td>UP</td>
<td>✓</td>
<td>Custom User Configuration via DashBoard</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>The MC1-PANEL-16 network settings can be set by the user from DashBoard using the Ethernet tab. However, DHCP Mode is assumed until the user changes the settings in DashBoard. <em>(Recommended)</em> This is the default positions.</td>
</tr>
<tr>
<td>UP</td>
<td>DOWN</td>
<td></td>
<td>Automatic Configuration using DHCP</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>The MC1-PANEL-16 network settings are automatically assigned (DHCP Mode).</td>
</tr>
<tr>
<td>DOWN</td>
<td>UP</td>
<td></td>
<td>Preset Configuration 1 using DIP switch(es)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>The MC1-PANEL-16 IP Address is set to 192.168.2.10 and the Subnet Mask is set to 255.255.255.0.</td>
</tr>
<tr>
<td>DOWN</td>
<td>DOWN</td>
<td></td>
<td>Preset Configuration 2 using DIP switch(es)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>The MC1-PANEL-16 IP Address is set to 10.1.2.10 and the Subnet Mask is set to 255.255.255.0.</td>
</tr>
</tbody>
</table>

**SW3**

**SW3** is not implemented at this time and should be left in the default UP position.
SW4 — Bootload Method

**SW4** should be left in the default **UP** position unless otherwise directed by Ross Technical Support.

### Power Connections

The MC1-PANEL-16 comes standard with one power supply, with a second optional power supply available for redundancy. For redundancy, and in applications where the equipment is used in a critical signal path, we recommend that two power supplies be used in the MC1-PANEL-16. One A/C power cable has been provided with each power supply ordered.

For further redundancy, each power cord should be connected to a separate power source for protection against failure of the A/C power circuit. In the event of one power supply failure, the panel load is seamlessly transferred to the other redundant power supply.

#### Power Supply Connectors (PS1, PS2)

There are two power supply connectors located on the rear of the MC1-PANEL-16:

- **PS1** — This connector is designated as the 12VDC Connector for the first power supply.
- **PS2** — This connector is designated as the 12VDC Connector for the second power supply.

### Power Cable Connection

This section includes information for connecting the power cables for the MC1-PANEL-16.

---

**Warning Hazardous Voltages** — *The safe operation of this product requires that a protective earth connection be provided. This protective earth is provided by the grounding conductor in the equipment’s supply cord. To reduce the risk of electrical shock to operator and service personnel, this ground conductor must be connected to an earthed ground.*

---

**Warning** — *In some countries, it may be necessary to supply the correct mains supply cord. Use only an approved IEC 320 C-13 type A/C line cord rated for a minimum 10A at 250V and certified for the country of use.*

---

**To connect the power cables for an MC1-PANEL-16**

1. Connect the 12VDC power cable into the connector marked **PS1**.

---

![MC1-PANEL-16 — Power Connections](image-url)

*Figure 3.4 MC1-PANEL-16 — Power Connections*
2. If the **Redundant Power Supply** option is available, plug the second 12VDC cable into the connector marked **PS2**.

3. Connect the supplied AC power cable into the power module and into the AC outlet.

### Control Panel Button Inserts

Insert films can be installed into most buttons on the MC1-PANEL-16. Insert films allow you to label specific source buttons, control buttons, or replace the default button names with those of a different language. Button insert template can be downloaded from Ross Video.

**To install a button insert**

1. Remove the Cap Assembly from the Switch Assembly by grasping it firmly and pulling away from the control panel surface.

2. Remove the Lens from the Diffuser using a common end micro screwdriver.

3. Place the Insert Film into the Lens so the readable side is facing up. The notches on the sides of the Lens must be at the sides of the text on the Insert Film.

4. Aligning the notices on the sides of the Lens and Diffuser, press the Lens and Diffuser together until they click.

5. Aligning the notches on the side of the Cap Assembly to the tabs on the side of the Switch Assembly, press the Cap Assembly down onto the Switch Assembly with a rolling motion until they click together.
Using DashBoard

Once you install the MC1-PANEL-16, you can access its interfaces in DashBoard. These interfaces provide options for configuring, monitoring, and operating your card in DashBoard.

Navigating to the Configuration Interface

This section provides a brief overview of navigating to the Configuration interface of the MC1-PANEL-16.

To launch DashBoard

1. Ensure that you are running DashBoard software version 6.2.0 or higher. The software and DashBoard User Guide are available from the Ross Video website.
2. Launch DashBoard by double-clicking its icon on your desktop.
3. Locate the MC1-PANEL-16 in the Tree View of DashBoard. If the MC1-PANEL-16 node does not appear, consult the DashBoard User Guide.

To display the Configuration interface

1. From the Tree View, expand the node for the MC1-PANEL-16 you wish to access.
2. Select the Configuration node to display the interface in the right-half of DashBoard.
Configuration

This chapter provides instructions for configuring the MC1-PANEL-16 using the options available in DashBoard.

Before proceeding, ensure that you are running DashBoard software version 6.2.0 or higher. The DashBoard software and user manual are available to download from the Ross Video website.

Before You Begin

Ensure that the following tasks are performed for each MC1-MK card that the MC1-PANEL-16 will communicate with:

1. **Select the Sources** — You must specify the video format and the reference source, and configure the outputs for each MC1-MK card that the MC1-PANEL-16 will interface with.

2. **Configure the SqueezeBack feature** — specifying the key order, configuring a tally/GPI for SqueezeBack.

3. **Configure the Audio sources** — Specify which audio group is embedded for outputs, specify how much the Program bus audio level is reduced when an EAS alert is active, specify whether the audio gain level is reset, to the factory default value of 0dB during transition, configure the embedded audio sources for the Voice Over feature for audio transitions.

*For More Information on...*

- performing these tasks, refer to the *MC1-MK Installation Guide* and the *MC1-MK Operation Guide*.

Configuring the Ethernet Communications

Contact your IT Department before configuring the network settings on your MC1-PANEL-16.

Each MC1-PANEL-16 includes an ethernet port on the rear panel. By default, this port is enabled and configured for DHCP. This section explains the necessary network communication settings and lists several possible methods for managing these settings.

- **Default configuration via DashBoard** — The MC1-PANEL-16 ships from the factory set to Custom User mode with DHCP selected. This enables it to establish initial communication via DashBoard. Once communication is established, you can change the network settings via DashBoard to implement a static address or continue using DHCP depending on your facility requirements. DHCP Mode is assumed until the user changes the settings in DashBoard.

- **Automatic Configuration using DHCP** — The MC1-PANEL-16 is configured to automatically obtain network settings from a Dynamic Host Configuration Protocol (DHCP) server.

- **Preset Configuration using DIP switch(es)** — The MC1-PANEL-16 can be forced to use specific pre-defined network settings by means of the DIP switches located on the chassis rear panel. This can be used to establish initial communications when no DHCP server is available, or to override a custom user configuration.

Initial Setup

Before proceeding, ensure that the DashBoard software is installed on your computer.

**To verify connection on initial power up**

1. Power on the MC1-PANEL-16.
2. Verify that the MC1-PANEL-16 IP address is reported on the chassis LCD Display.
3. Launch DashBoard.
4. Verify that the MC1-PANEL-16 displays in the Tree View.
To run in DHCP Mode
If you wish to run in DHCP mode only, set SW1 to UP and SW2 to DOWN.

To run in Static Mode
1. Set SW1 to UP and SW2 to UP.
2. Configure the new settings as outlined in the section “Custom User Configuration via DashBoard” on page 26.

To verify the IP address of the MC1-PANEL-16
1. Verify that the correct IP address is reported on the MC1-PANEL-16 LCD Display.
2. Ensure that the MC1-PANEL-16 displays in the Tree View of DashBoard.
3. Verify that the information reported in the Ethernet tab is correct:
   a. Select the Configuration node to display the interface in the right-half of DashBoard.
   b. Select the Ethernet tab.
   c. Ensure the fields in the Ethernet tab are reporting the correct settings.

Troubleshooting
If the MC1-PANEL-16 has been previously setup, but you cannot get to the IP address (or it is on the wrong subnet) reported on the chassis display:
1. Set SW1 to UP and SW2 to DOWN (DHCP mode).
2. Verify that the MC1-PANEL-16 IP address is reported on the chassis display.
3. Launch DashBoard.
4. Verify that the MC1-PANEL-16 displays in the Tree View.
5. If the MC1-PANEL-16 is displayed in DashBoard:
   a. Set SW1 to UP and SW2 to UP (Custom User mode).
   b. Configure the new settings as outlined in the section “Custom User Configuration via DashBoard” on page 26.
6. If you still cannot establish a connection to the MC1-PANEL-16:
   a. Set SW1 and SW2 to one of the Preset Configurations. Refer to Table 3.1 for switch positions.
   b. Proceed to the section “Preset Configuration using the DIP Switches” on page 27.

Custom User Configuration via DashBoard
Once communication is established with the MC1-PANEL-16, the network settings may be adjusted using the following procedure. Note that the steps are optional, you may perform as many, or as few, as needed.

* Some settings may require that you configure a DIP Switch before proceeding. Refer to the section “Setting the DIP Switches” on page 20 for details.

To configure the network settings via DashBoard
1. From the Tree View, expand the node for the MC1-PANEL-16 you want to access.
2. Select the Configuration node to display the interface in the right-half of DashBoard.
3. Select the Ethernet tab.
4. To change between Static and DHCP addressing, select an option in the Method area.

5. If you chose Static in step 4, configure the network settings as required for your facility:
   - **IP Address** — This is the IP Address of the MC1-PANEL-16. Contact your IT Department to receive a unique IP address for your MC1-PANEL-16.
   - **Subnet Mask** — This is the Subnet Mask address for your LAN.
   - **Default Gateway** — This is the IP Address for connection outside the subnet.

6. To save the new settings, click **Apply** in the Ethernet tab.

**Automatic Configuration using DHCP**

This method assumes that the MC1-PANEL-16 is using the factory default values for the network settings.

**To establish communications**

1. Ensure that the MC1-PANEL-16 is connected to the same network as your DashBoard computer.
2. Launch the DashBoard application on your computer.
3. Power on the MC1-PANEL-16.
4. Wait approximately 30 seconds while the MC1-PANEL-16 establishes network communications.
5. Verify that the MC1-PANEL-16 displays in the Tree View of DashBoard.
6. Should the MC1-PANEL-16 fail to display after two minutes:
   a. Verify the ethernet cables are properly connected.
   b. Check the link/activity LEDs found on the ethernet RJ-45 connectors.
   c. Ensure the network settings for the MC1-PANEL-16 are set.
   d. If all cables are connected and the LEDs do not indicate an error, then automatic configuration is not possible. Proceed to the section “**Preset Configuration using the DIP Switches**” on page 27.

**Preset Configuration using the DIP Switches**

This method is used to establish initial communications when no DHCP server is available, or to override a custom user configuration and is intended to be used temporarily in order to establish communication. Once initial communications are established, the MC1-PANEL-16 should be configured for either DHCP or Static operation.
Use of this method for normal operation is not recommended, as there is a high chance of IP Address conflicts.

**To use a preset network configuration using the DIP Switch(es)**

1. Power down the MC1-PANEL-16.
2. Quit DashBoard on your computer.
3. Set the DIP Switches to specify the preset IP Address as outlined in the section “Setting the DIP Switches” on page 20.
4. Ensure the network settings of your computer are compatible with those chosen for the MC1-PANEL-16.

The IP Addresses of the MC1-PANEL-16 and your computer must be similar, but not identical, and the Subnet Mask must match exactly the same. For example, if the MC1-PANEL-16 has an IP Address of 192.168.2.2, then your computer should be configured for an IP Address with 192.168.2.X where X is a number other than 2.

5. Before you begin, and to prevent IP Address conflicts, isolate the MC1-PANEL-16 and your DashBoard computer from the rest of your network.
   - If you are using a hub or switch, unplug all devices except the MC1-PANEL-16 and your DashBoard computer; or
   - Connect the MC1-PANEL-16 directly to the DashBoard computer.

The MC1-PANEL-16 supports Auto-MDIX, enabling you to use any ethernet cable when connecting the frame to the DashBoard computer.

6. Launch DashBoard on your computer.
7. Power up the MC1-PANEL-16.
8. Wait approximately 30 seconds while the MC1-PANEL-16 establishes network communications.
9. Verify that the MC1-PANEL-16 displays in the Tree View of DashBoard.
10. Should the MC1-PANEL-16 fail to display after a minute or two:
    a. Verify the ethernet cables are properly connected.
    b. Check the link/activity LEDs found on the ethernet RJ-45 connectors.
    c. Verify that you have properly performed each step of this procedure.
    d. Contact Ross Video Technical Support if you cannot establish a connection.

11. Once communication is established:
    a. Set **SW1** to **UP** and **SW2** to **UP**.
    b. Navigate to the **Ethernet** tab for the MC1-PANEL-16 in DashBoard.
    c. Enter the new IP Address you wish to assign to the MC1-PANEL-16.

**MC1-PANEL-16 Personality**

There are a number of settings for how the MC1-PANEL-16 will react to different situations, or how the panel elements appear to the operator.

**Setting the Panel Name**

You can choose to give the MC1-PANEL-16 a unique name that displays in the Tree View of DashBoard.

**To set the panel name**

1. From the **Tree View**, expand the node for the MC1-PANEL-16 you want to access.
2. Select the **Configuration** node to display the interface in the right-half of DashBoard.
3. Select the **Panel Name, Permission** tab.
4. Type a unique identifier in the **Panel Name** field.
5. Press **Enter** to apply the new name.

### Configuring the Edit Permissions

You choose to lock the MC1-PANEL-16 permissions so that all configurable parameters are read-only and cannot be changed.

**To configure the card edit permissions**

1. From the **Tree View**, expand the node for the MC1-PANEL-16 you want to access.
2. Select the **Configuration** node to display the interface in the right-half of DashBoard.
3. Select the **Panel Name, Permission** tab.
4. Choose an option from the **Edit Permission** menu.

### Configuring the Power Supply Alarms

The **Alarm Enables** tab provides options for enabling the monitoring of the power supplies installed in the MC1-PANEL-16. When an alarm is enabled for a power supply, a message is displayed in the **Hardware** tab when that power supply input voltage is out of range (<11.5A or >12.5A).

**To configure the power supply alarms**

1. From the **Tree View**, expand the node for the MC1-PANEL-16 you want to access.
2. Select the **Configuration** node to display the interface in the right-half of DashBoard.
3. Select the **Alarm Enables** tab.
4. From the **PSU Alarm Enable** area, select the box for the power supply you wish to monitor for voltage.

### Mnemonic Display

The mnemonic displays under the Program bus shows the name of the source assigned to the crosspoint button directly below it. The Channel Select buttons are mnemonic push-buttons. The overall mnemonic color and contrast scheme of the panel can be adjusted.
To modify the mnemonic display for a channel
1. From the Tree View, expand the node for the MC1-PANEL-16 you want to access.
2. Select the Configuration node to display the interface in the right-half of DashBoard.
3. Select the Channel, Mnemonic, LCD tab.
4. Use the Mnemonic Contrast field to specify the difference in brightness between the text and the background of the mnemonic display.
5. Use the Mnemonic Color field to select the background color of all mnemonics on the MC1-PANEL-16.

LCD Display
You can edit the figure to ground contrast of the text on the display area of the MC1-PANEL-16 chassis.

To modify the LCD contrast for a channel
1. From the Tree View, expand the node for the MC1-PANEL-16 you want to access.
2. Select the Configuration node to display the interface in the right-half of DashBoard.
3. Select the Channel, Mnemonic, LCD tab.
4. Use the LCD Contrast field to specify the difference in brightness between the text and the background of the display on the MC1-PANEL-16.

Loading the Factory Defaults
If required, the MC1-PANEL-16 menu parameters can be reset to the factory default values using the option available in the Load/Save tab.

To reset the card to the factory default settings in DashBoard
1. From the Tree View, expand the node for the MC1-PANEL-16 you want to access.
2. Select the Configuration node to display the interface in the right-half of DashBoard.
3. Select the Load/Save tab.
4. From the Global Settings area, click Load Factory Defaults to display the Confirm dialog.
5. Click Yes to load the factory default values for all menu parameters, or No to cancel the load and close the dialog.

Assigning an MC1-MK Card to a Channel Button
There are ten channel buttons available on the MC1-PANEL-16. A button selects a specified MC1-MK card, and assigns the MC1-PANEL-16 control over that card. When selected, the panel assumes the crosspoint mapping and personality of that card. To help differentiate between channels, options are provided for configuring colors schemes for each channel, giving a visible indication on the panel itself of which channel is currently selected and on-air via the MC1-PANEL-16.

For More Information on...
• selecting a color scheme for a channel, refer to the section “Configuring the Channel Personality” on page 31.

To assign an MC1-MK card to a Channel
1. From the Tree View, expand the node for the MC1-PANEL-16 you want to access.
2. Select the Configuration node to display the interface in the right-half of DashBoard.
3. Select the Channel, Mnemonic, LCD tab.
4. Locate the MC1-MK card you wish to assign to the MC1-PANEL-16 Channel button as follows in the Tree View.

5. Drag and drop the MC1-MK card node to the required Channel button on the MC1-MK Panel Channel, Mnemonic, LCD tab. The button now displays the logo for the assigned MC1-MK card.

6. Type a unique identifier in the Channel Name field. This name displays in the mnemonic button on the MC1-PANEL-16 chassis and is reported in the LCD Display when the channel is on-air. There is a 12 character maximum.

Configuring the Channel Personality

You can specify that each channel has a specific color scheme, name, mnemonic contrast and color, and specific chassis display contrast.

Specifying the Number of Available Crosspoints

This number is in addition to the Shift button.
To specify the number of available crosspoints
1. Locate the MC1-MK card in the Tree View.
2. Select the Configuration node to display the Configuration interface for that card.
3. Select the Config tab.
4. Select the Personality tab.

5. Use the Number of Crosspoint Buttons slider to specify:
   - the number of crosspoint buttons to display in the Active Channel On Air Control interface, and
   - the number of active crosspoint buttons on the MC1-PANEL-16 chassis. Buttons that are unavailable are unlit on the physical panel.

Displaying the On Air Control Interface
You can choose whether to display the entire On Air Control interface or the upper portion of the interface on a DashBoard client computer when the MC1-PANEL-16 is connected.

To specify how to display the On Air Control interface
1. Locate the MC1-MK card in the Tree View.
2. Select the Configuration node to display the Configuration interface for that card.
3. Select the Config tab.
4. Select the Personality tab.
5. From the Crosspoints & Keyers options in the On Air Control area, select how much of the interface to display in DashBoard. You may need to scroll to the bottom of the tab to access these options.

Disabling the Fade to Black Button
You can disable the functionality of the Fade to Black (FTB) button on both the On Air Control interfaces and the physical button on the MC1-PANEL-16 chassis. Once disabled, pressing the button has no effect.

* Ensure that FTB is not selected or in use before disabling its function. Disabling the button while it is selected (active) locks the on-air output to black.
To disable the FTB button

1. Locate the MC1-MK card in the Tree View.
2. Select the Configuration node to display the Configuration interface for that card.
3. Select the Config tab.
4. Select the Personality tab.
5. To disable the FTB button, select the Disable FTB box.

Color Schemes

The buttons on the MC1-PANEL-16 can be set to glow with a custom color, you can choose what color denotes an on air button. This feature is especially useful when accessing multiple MC1-MK channels and assigning a different color to each channel offers quick identification. You will need to repeat this procedure for each channel.

Each color dialog requires that you either click Live (to preview the color scheme and apply it but not close the dialog) or OK (to apply the new color scheme and close the dialog). Clicking off the dialog closes the dialog without applying your changes.

To select a channel color scheme

1. From the Tree View, expand the node for the MC1-PANEL-16 you want to access.
2. Select the Configuration node to display the interface in the right-half of DashBoard.
3. Select the Channel, Mnemonic, LCD tab.
4. Use the Panel Button Color field to specify a color for buttons not located in the Program or Preset buses. Proceed to step step 8.
5. Use the PGM Background Color field to specify a color for unselected buttons located in the Program bus. Proceed to step step 8.
6. Use the On Air Color field to specify a color for buttons that are selected and on-air. This also applies to the TAKE button. Proceed to step step 8.
7. Use the On preset Color field to specify a color for buttons located in the Preset bus. Proceed to step step 8.
The Transparency menu is not implemented.

8. Use the **Hue** options to specify whether the color is red yellow, green, blue, purple etc. Or you can select the hue from the provided vertical color grid in the dialog.

9. Use the **Saturation** options to specify the depth of the color.

10. Use the **Lightness** options to specify the amount of white or black mixed with the hue selected in step 8.

11. Confirm that the field beneath the color grids displays the selected color.

12. Apply your changes using one of the following options:
   - Click **Live** to preview the color scheme and apply it but not close the dialog; or
   - Click **OK** to apply the new color scheme and close the dialog.
Operation

This chapter provides a summary of how to perform on the MC1-PANEL-16 such as: transitions and keying. Before performing any of the tasks in this chapter, ensure the MC1-PANEL-16 is not locked.

Active Channel On Air Control Interface

When a Channel button on the MC1-PANEL-16 is selected and communicating with an MC1-MK card (channel), the Active Channel On Air Control interface that displays in DashBoard mimics that MC1-MK card’s On Air Control interface. You must have at least one channel configured before accessing the Active Channel On Air Control interface.

For More Information on...

• channel setup, refer to the section “Assigning an MC1-MK Card to a Channel Button” on page 30.
• the controls available in the MC1-MK On Air Control interface, refer to the MC1-MK Operation Guide.

To access the Active Channel On Air Control interface

1. Ensure that you are running DashBoard software version 6.2.0 or higher. The software and DashBoard User Guide are available from the Ross Video website.
2. Launch DashBoard by double-clicking its icon on your desktop.
3. Locate the MC1-PANEL-16 in the Tree View of DashBoard. If the MC1-PANEL-16 node does not appear, consult the DashBoard User Guide.
4. From the Tree View, expand the node for the MC1-PANEL-16 you wish to access.
5. Verify that an MC1-MK card is assigned to the Channel 1 button.
6. Select the Active Channel On Air Control node to display the interface in the right-half of DashBoard.

Troubleshooting

If you are unable to launch the Active Channel On Air Control interface in DashBoard, and instead encounter the message “Waiting to Locate”, your MC1-PANEL-16 is unable to establish communications with each MC1-MK card assigned to a channel for the panel. Verify that each MC1-MK card you assigned to a channel displays in the Tree View of DashBoard. If they are not listed, you must re-establish communications between the MC1-MK cards and the MC1-PANEL-16.
There are two methods for re-establishing communications: using Auto Discovery, and manually adding the frame using its IP address. This section briefly outlines how to use both methods.

**To use auto discovery**

- Perform one of the following:
  - Use the **Auto Discovery** feature in DashBoard to quickly refresh communications and the list of devices listed in the **Tree View**. This is the preferred method especially if you suspect that more than communication was lost to more than one MC1-MK card.
  - From the Tree View, click 🔄. This enables DashBoard to query the network and automatically add any new frames to the Tree View.

**For More Information on...**

- configuring the auto discovery feature to always detect new devices, refer to the **DashBoard User Manual**.

**To manually add an openGear frame**

Manually add the frame(s) with the MC1-MK cards to the Tree View. You will need the IP address of each frame. Refer to the **DashBoard User Guide** for more details.

1. Select **File > New > TCP/IP openGear Frame**.
2. Expand the openGear node.
3. Select **TCP/IP openGear Frame** to display the **New TCP openGear Frame Connection** dialog box.
4. In the text fields provided, enter the IP Address of the openGear frame you wish to add,
5. Select **Detect Frame Information**. Once DashBoard detects the information, the **Automatically Track Updates to Frame Information** box is selected so that any changes are automatically updated in DashBoard.
6. Select **Finish**.
7. Verify that the frame now displays in the Tree View.

**Selecting a Master Control Channel**

A single MC1-PANEL-16 is able to control multiple Master Control channels (MC1-MK cards). When you assign a card to a Channel Select button, you have the ability to switch between different channels by selecting the corresponding buttons on the chassis. When a new channel is selected, the MC1-PANEL-16 state (including the crosspoints and mnemonics) is updated.

When you select a channel button:

- The Active Channel On Air Control interface represents the selected channel (MC1-MK card) assigned to that channel. A message displays in the upper right corner of the interface, indicating that this the active (on air) channel.
- The MC1-PANEL-16 communicates with the MC1-MK cards over ethernet.

**To select a Master Control channel**

1. Ensure that you have assigned MC1-MK cards to the required channel buttons as outlined in the section “Assigning an MC1-MK Card to a Channel Button” on page 30.
2. Press one of the **Channel Select** buttons located on the top left corner of the MC1-PANEL-16 chassis.
   - The Channel Select button on the MC1-PANEL-16 chassis is now lit and flashing.
   - The display on the MC1-PANEL-16 chassis reports the channel name and IP address of the openGear frame the selected MC1-MK card is installed in.
   - Your DashBoard client displays the On Air Control interface for that channel.
   - The state of the MC1-PANEL-16 now matches the state of the selected MC1-MK card.
Channel Ganging

Each MC1-MK can operate as either master or remote channel depending on the role assigned to it in the Remote Control tab of its Configuration interface. The master MC1-MK passes all supported commands to each remote MC1-MK with a valid connection to it.

When channel ganging is enabled, the Home tab of the MC1-MK reports its channel gang status on the same line as the EAS Status (located at the bottom of the Home tab).

For More Information on...
- setting up channel ganging, refer to the MC1-MK Installation Guide.
- the commands supported by channel ganging, refer to the MC1-MK Operation Guide.
- status messages on the Home tab, refer to the MC1-MK Operation Guide.

Transitions

Transitions are used to change the background video and take keys on and off-air for the active Channel. A transition can include any combination of Background video, and keys. The BKGD A (Program) and BKGD B (Preset) inputs allows for background dissolves and V-Fades behind the external key source of the active channel.

1. Keyer Area

The Keyer Area enables you to add, or remove, keyers in transitions. This area includes the following controls:
- The top row of buttons, labeled Key 1-4, are used to perform cuts on the specified keyer directly on the Program Bus, without affecting their inclusion in the next transition. A lit button indicates that the specified keyer is currently on-air.
The middle row includes mnemonics that display
The bottom row of buttons, labeled Key 1-4, are used to add, or remove, the specified keyer to the next transition. Selecting the button toggles the keyer on/off and selects/removes the keyer to the Preset Bus respectively. Once the transition is executed, and depending on a Personality tab setting, the button(s) are no longer lit in this row but are lit red in the top row.

2. Transition Type Buttons

The following Transition Type buttons are available (from left to right):

› **T** (Cut) — Select this button to perform a cut transition from one source to the next or to cut to a squeeze effect. This type can be combined with a squeeze effect.

› **V** (V-Fade) — Select this button to perform a V-Fade transition from the Program source to Black to the Preset source. The MC1-PANEL-16 fades down from one source to black and then transitions to the next source. During a hot-punch transition, the video performs a CUT while the audio performs a V-Fade. This type can be combined with a squeeze effect.

› **✓** (Cut-Fade) — Select this button to perform a cut to black, then fade up to the next source. This type can be combined with a squeeze effect.

› **X** (Cross Fade) — Select this button to perform a gradual fade from one source to the next. The MC1-PANEL-16 performs a cross fade between sources. Note that this button is selected after performing a factory default reset. This type can be combined with a squeeze effect.

› **✓** (Fade-Cut) — Select this button to fade from one source to black and then cut to the next source. This type can be combined with a squeeze effect.

› **☐** (SqueezeBack) — Select this button to perform a SqueezeBack effect by reducing the size of the video over time to the dimensions set in the Squeeze Effects tab. Unlike the above types, you may not change your background or keys on-air with this transition type. The corresponding buttons are grayed out.

3. Transition Speed Buttons

These buttons apply the rate (slow, medium, fast) to the next transition. The transition rates are specified in the Home tab of the MC1-MK. Note that the Slow button is selected after performing a factory default reset.

4. FTB Button

Use this button to fade the Program bus to black. The Fade to Black (FTB) rate is specified in the Home tab. After performing a factory default reset, this button is toggled off (unlit).

5. BKGD INCL Button

The BKGD INCL button is used to add, or remove, the BKGD from the next transition. Toggling this button will immediately affect the Background video that is visible on the Preset output.

6. SQZ INCL Button

The SQZ INCL button is used to add or remove, the selected squeeze effect preset from the next transition. Toggling this button will immediately affect the video that is visible on the Preset output. You may use this button while a squeeze effect is on air to perform transitions within the squeeze effect. This can be done with a Squeeze transition to perform a SqueezeBack, or as part of another transition (Take, Mix, Fade-Fade).

7. TAKE Button

Selecting the TAKE button performs the transition between the sources and effects selected in the Program and Preset buses, using the specified Transition Type and Transition Speed. Refer to the previous sections for information on the corresponding buttons in the Keyers Area.

For More Information on...
• setting the transitions rates, refer to the MC1-MK Operation Guide.
Performing Transitions

You can perform transitions in one of the following manners: hot-punching a crosspoint on the Program bus, selecting a Keyer (1-4) button from the Keyer Area to transition a keyer on or off air, and using the options in the Transition Area to add elements to the transition.

To perform a transition

1. Press the required Channel Select button on the MC1-PANEL-16.
2. In the Transition Area, select the elements you want to add to the next transition by selecting the BKGD INCL button to add the Background video source, and the Key 1-4 buttons to add the required keyer(s).
3. On the Preset bus, select the video source you want to take on-air.
4. Select a Transition Speed button (Slow, Medium, or Fast).
5. Select a Transition Type button.
6. Select TAKE.

To perform a Fade to Black

The FTB button allows you to fade to black, where the Program bus is faded to black at the FTB rate. Note that this also removes any EAS text and audio from the output. The Fade to Black rate is set in the Home tab as outlined above. When the FTB button is selected, or lit, the MC1-PANEL-16 performs an Auto transition to black.

For More Information on...

• disabling the FTB button, refer to the section “Disabling the Fade to Black Button” on page 32.

Transition Notes

Keep the following in mind when performing transitions:

• To allow for audio cross fading, a cut takes two frames. One frame is used for the audio fade down, the video is then cut, followed by the one frame audio fade up.

• The speed at which the Auto transition is performed, in number of frames, is determined by the setting (Slow, Medium, or Fast) in the Transition Rate area. Before proceeding, ensure the Transition Type is set to the desired type.

• When switching between router sources, there is an additional time after the (visible) transition, while the router sources are switched. If you see a glitch at the end of the transition, this indicates that the Delay setting in the Router setup tab is set too low.

• If a crosspoint or transition button is selected while a transition is in progress, the original transition continues as subsequent button presses are ignored (except the FTB button).

• Verify how the Toggle Program/Preset Bus and Disarm Preset Keyers options are configured in the Personality tab. Refer to the MC1-MK Installation Guide for details on configuring these options.

SqueezeBack Effects

The MC1-PANEL-16 can be used to perform on-air SqueezeBack transitions to reveal another video source or graphic. You can also transition to pre-squeezed effects with standard transitions, squeeze in any direction on either X or Y axis, or both. Four SqueezeBack presets on each MC1-MK card are provided for quick effect recalls on the fly.

This section briefly outlines the SqueezeBack Effects controls of the MC1-PANEL-16.
Figure 6.2  MC1-PANEL-16 —SqueezeBack Effects Controls

1) EFF SEL Button and Status Field  2) SQUEEZE Button  3) SQZ INCL Button

1. EFF SEL Button and Status Field

The Effect # status field on the display reports the last applied effect and whether it is on or off air, or currently on the Preset Bus. While the squeeze effect is on air:

› the EFF SEL button is locked (read-only, and dimly lit in the On Air Color). Even though you can still adjust the options in the SqueezeBack Effects tabs, we suggest not doing so since all effect changes are immediately applied.

› you are unable to change the background or keys with a transition. However, you can still hot-punch a source or key on the Program bus. However, hot-punching a source on the Program bus will take the squeeze effect off air. Hot-punching keys on/off will not take the squeeze effect off air.

2. SQUEEZE Button

Selecting this button applies the squeeze effect (as specified using the EFF SEL button) to the next transition. Note that the SQUEEZE button will be selected (lit) but not locked out when the transition type is Squeeze, or when a squeeze effect is on air.

3. SQZ INCL Button

Selecting this button performs a SqueezeBack effect with the transition. You must pre-configure your SqueezeBack presets, then select the preset you want to apply to the transition before executing your transition.

For More Information on...
• configuring the SqueezeBack presets, refer to the MC1-MK Operation Guide.

Performing Transitions with SqueezeBack Presets

Keep the following in mind when performing transitions with SqueezeBack presets:
• You can pre-define up to four different SqueezeBack Presets (Effects 1-4)
• A squeeze effect does not consume any existing keyers and you can specify any of the logo channels to use as a reveal source for that effect.
• When the video format is 480i 59.94, the Line 21 closed captioning is re-inserted from the video source into the output when the NTSC Pass Line 21 setting is enabled. Refer to the MC1-MK Installation Guide for details.
• Hot-punches on the Program bus can be performed within an on air squeeze effect.
• Squeeze effect transitions are also supported under the Presmaster automation protocol. Refer to the MC1-MK Installation Guide for details on this protocol.
• You can also trigger a squeeze effect using a GPI trigger. Refer to the *MC1-MK Installation Manual* for setup details.
• You can configure a tally to raise when the reveal source is visible. This tally will be raised regardless of the configured source. This can be used in cases when a graphics station is providing the video and needs to know when to trigger the playing of an animation. Refer to the *MC1-MK Installation Manual* for setup details.

**Previewing a Squeeze Effect**

You can preview your Effect preset on the Preview monitor without affecting the Program bus. However, during a SqueezeBack transition the preview output is not accurate.

**To preview a Squeeze Effect**

1. Set up your effect as outlined in the *MC1-MK Operation Guide*.
2. Select the required **Channel Select** button on the MC1-PANEL-16.
3. Use the **EFF SEL** button to specify the desired squeeze effect for the transition.
4. Select the **SQZ INCL** button.

**Transitions with SqueezeBack**

This section provides examples of executing transitions that include SqueezeBack Preset.

**Basic Transition with a Squeeze Effect**

*Operation:* This is a SqueezeBack transition.

1. Set up your effect using the tabs in the **SqueezeBack Effects** tab as outlined in the *MC1-MK Operation Guide*.
2. Use the **EFF SEL** button to specify the desired squeeze effect for the transition. This is the effect that you configured in step 1.
3. Select \( \) in the **Transition Type** area. The **Effect #** status field now indicates ON PST. You can preview the squeeze dimensions on your Preview monitor.
4. Select the **SQZ INCL** button.
5. Select **TAKE**.

**Dissolve to a Static Squeeze Effect**

*Prerequisite:* You have a pre-squeezed effect ready on Preview.

*Description:* When you select **TAKE**, the Program dissolves to the pre-squeezed effect. After you have set up the transition, and during the transition, the Preview monitor is accurate.

*Operation:*

1. Select the **EFF SEL** button to specify the desired squeeze effect for the transition.
2. Select a dissolve transition type (Fade-Fade, Take-Fade).
3. Ensure the **SQZ INCL** button is selected.
4. The Preview monitor shows the squeeze effect.

**Keying**

Keying is the term used to describe when you insert (or electronically cut) portions of one screen into another, or place titles over background images. Keys are made up of two basic components: an alpha (that cuts the hole in the background video), and a fill (that fills the hole with different video). This section provides a summary of the MC1-PANEL-16 keying features.
Overview

MC1-PANEL-16 includes four high quality HD/SD-SDI video keyer. In addition to the external Key Video and Key Alpha source, there are also four internal static/animation play-out channels. An excellent device for keying external devices such as character generators, graphic systems and EAS devices into a program feed and/or keying with four internal logo channels.

![Figure 6.3 MC1-PANEL-16 — Keyer Controls](image)

1) Program Keyer Select Buttons                2) Preset Keyer Select Buttons

1. Program Keyer Select Buttons

When lit red, a button indicates that specific keyer is currently on-air on the Program bus. Selecting a button will immediately perform cuts on that keyer.

2. Preset Keyer Select Buttons

These buttons are used to choose which keyer is included in the next transition. Note that depending on a Personality tab setting, once a transition is performed, the button(s) are no longer lit.

For More Information on...

- configuring a key, refer to the *MC1-MK Operation Guide*.
- loading media files to logo channels, refer to the *MC1-MK Operation Guide*.
- changing the crosspoint naming and/or mapping, refer to the *MC1-MK Installation Guide*.

Audio

This section briefly summarizes the audio monitoring and controls available for the MC1-PANEL-16.
1. AUDIO GAIN

Use the knob to apply an audio gain value on the Program and Preset bus. The gain range is -72dB to +12dB. Press the knob to set the gain value to 0.

2. AUDIO OVER Buttons

An AUDIO OVER button is included on each bus. Selecting the button in the PST bus includes the voice over channel in the next transition. You can also hot-punch the AUDIO OVER button in the Program bus.

Setting the Master Audio Level

The master audio level can be adjusted manually using the knob located next to the display on the MC1-PANEL-16. This applies a gain (in dB), to the audio that is included with the output.

To set the Master Audio level

1. Press the applicable Channel Select button on the MC1-PANEL-16.
2. Rotate the knob clockwise to increase the gain, or counter-clockwise to decrease the gain.
3. Press the knob inward to set the audio gain to 0dB.

Performing Transitions

During transitions, the audio ramps smoothly between Program and Preset sources, matching the video transition. All channels of enabled groups are processed, even though the final output level for only the first eight channels is displayed on the Audio Meters.

Keep the following in mind when performing transitions including audio:

- A two-frame V-Fade is performed on the audio if a different source is hot-punched on the Program bus.
- Audio transitions are Mix or V-Fade (on video fade, and cuts). However, during cut transitions, the audio transition is a V-Fade.
- Depending on how the Reset Audio Gain feature is configured, the audio gain level may be reset to 0dB after a transition. Refer to the MC1-MK Installation Guide for details.

For More Information on...

- setting EAS audio, refer to the MC1-MK Installation Guide.

Voice Overs

The MC1-PANEL-16 enables flexible audio/voice over mixing with a variable program audio duck level, audio over gain control, and preset mixing with transition control. When Voice Over or EAS is active, all channels are
mixed. If the source contains more audio channels that you want mixed, ensure to use the Mute setting for those channels. The Voice Over source is selected using the Audio Over Selection tab in the Configuration interface of the MC1-MK card. A Voice Over can also be triggered using GPIs.

For More Information on...

- setting up GPIs, refer to the MC1-MK Installation Guide.
- setting the Voice Over duck/gain level, refer to the MC1-MK Operation Guide.

Including a Voice Over

The Voice Over feature is triggered on/off by pressing the AUDIO OVER button. Once the button is selected (button is lit), the voice over will remain active until the button is selected again (button is unlit).

For More Information on...

- selecting the source for your Voice Over, refer to the MC1-MK Installation Guide.
Software Upgrades

The MC1-PANEL-16 can be upgraded in the field using its Ethernet 1 port and the options available in DashBoard.

If the MC1-PANEL-16 fails to upgrade correctly, contact Ross Technical Support for an upgrade file and instructions on using the Micro SD Card slot on your panel.

**To upgrade the software on the MC1-PANEL-16**

2. Ensure the ethernet cable is connected to the Ethernet 1 port. Refer to the section “Ethernet Cabling” on page 19 for details.
3. From the Tree View, expand the node for the MC1-PANEL-16 you want to access.
4. Select the Configuration node to display the interface in the right-half of DashBoard.
5. Select Upload, located near the bottom of the Config tab, to display the Select file Upload dialog.
6. Navigate to the *.bin file you want to upload.
7. Click Open.
8. If you are upgrading a single MC1-PANEL-16, click Finish to start the upgrade. Proceed to 10
9. If you are upgrading multiple panels:
   a. Click Next > to display the Select Destination menu. This menu provides a list of the compatible devices.
   b. Specify the device(s) to upload the file to by selecting the box(es) for those devices you want to upload the file to.
   c. Verify the device(s) you want to upload the file to. The Error/Warning fields indicate any errors, such as incompatible software or device type mismatch.
   d. Click Finish.
10. Monitor the upgrade.
    a. An Upload Status dialog enables you to monitor the upgrade process.
    b. Notice that each device is listed in the dialog with a button. This button is replaced with a Reboot button once the software file is loaded to that MC1-PANEL-16.

Avoid clicking the individual Reboot buttons until all devices have successfully completed the file upload process and the OK button, located in the bottom right corner of the dialog, is enabled.

c. Click OK to reboot all the devices listed in the Uploading to Selected Devices dialog.

d. The Reboot Confirm dialog displays, indicating the number of devices that will reboot. Click Yes to continue the upgrade process. Note that clicking Cancel or No returns you to the Uploading to Selected Devices dialog without rebooting the device(s).

e. Each MC1-PANEL-16 is temporarily taken off-line during the reboot process. The process is complete once the status indicators in DashBoard return to their previous status.
DashBoard Menus

This chapter briefly summarizes the menus, items, and parameters available in the MC1-PANEL-16 Configuration interface. Default values are noted with an asterisk (*).

Before proceeding, ensure that you are running DashBoard software version 6.2.0 or higher. The DashBoard software and user manual are available to download from the Ross Video website.

Status Tabs

This section summarizes the read-only information displayed in the Status tabs. The fields in the Status tabs vary in severity from green (valid), yellow (caution), to red (alarm). DashBoard reports the most severe alarm for a single field. Alarm colors are noted within the tables as text set in brackets next to the menu parameter name.

Hardware Tab

Table 8.1 summarizes the read-only information displayed in the Hardware tab.

<table>
<thead>
<tr>
<th>Item</th>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Panel Status</td>
<td>OK (Green)</td>
<td>Normal operation; no hardware errors and the correct rear module is installed</td>
</tr>
<tr>
<td>Alarm suppressed (Green)</td>
<td></td>
<td>The PSU# Voltage Out of Range alarm(s) is not selected in the Alarm Enable tab. Refer to Table 8.6.</td>
</tr>
<tr>
<td>PSU# voltage out of range (Red)</td>
<td></td>
<td>The PSU# Voltage Out of Range alarm(s) is selected in the Alarm Enable tab and the indicated power supply unit is experiencing an input voltage that is not within the acceptable range</td>
</tr>
<tr>
<td>No active connection to MC1-MK (Red)</td>
<td></td>
<td>The MC1-PANEL-16 is not communicating with an MC1-MK card assigned to a channel on the MC1-PANEL-16</td>
</tr>
<tr>
<td>PSU# Voltage (V)</td>
<td>#</td>
<td>Measured input voltage</td>
</tr>
<tr>
<td>Current (mA)</td>
<td>#</td>
<td>Current consumption of card in milliamperes</td>
</tr>
<tr>
<td>Power (W)</td>
<td>#</td>
<td>Calculated power of the card</td>
</tr>
<tr>
<td>Processor Temp</td>
<td>##C / ##F</td>
<td>Indicates the processor core temperature.</td>
</tr>
<tr>
<td>CPU Usage</td>
<td>x.xx/y.yy/z.zz</td>
<td>CPU Load average where:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• x.xx represents in the last minute</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• y.yy represents the last five minutes</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• z.zz is the last fifteen minutes</td>
</tr>
<tr>
<td>RAM Available</td>
<td>##/##</td>
<td>CPU Memory Used / Total CPU Memory</td>
</tr>
</tbody>
</table>
Product Tab

Table 8.2 summarizes the read-only information displayed in the Product tab.

<table>
<thead>
<tr>
<th>Item</th>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Panel Name</td>
<td>#</td>
<td>Name of the MC1-PANEL-16 as specified in the Panel Name, Permission tab</td>
</tr>
<tr>
<td>Product</td>
<td>MC1-PANEL-16</td>
<td></td>
</tr>
<tr>
<td>Supplier</td>
<td>Ross Video Ltd.</td>
<td></td>
</tr>
<tr>
<td>Board Rev</td>
<td>##</td>
<td>Indicates the board issue</td>
</tr>
<tr>
<td>Serial Number</td>
<td>######</td>
<td>Indicates the board serial number</td>
</tr>
<tr>
<td>Software Rev</td>
<td>#.# build ###</td>
<td>Indicates the software and build versions</td>
</tr>
<tr>
<td>Firmware Rev</td>
<td>###.###</td>
<td>Indicates the FPGA version number</td>
</tr>
</tbody>
</table>

Ethernet Tab

Table 8.3 summarizes the Ethernet options for setting up network communications for your MC1-PANEL-16.

<table>
<thead>
<tr>
<th>Item</th>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ethernet 1</td>
<td>MAC Address (read-only)</td>
<td>The MAC Address for the MC1-PANEL-16 ethernet port</td>
</tr>
<tr>
<td></td>
<td>OK</td>
<td>Ethernet communications for the Ethernet 1 port are valid</td>
</tr>
<tr>
<td></td>
<td>Link Down</td>
<td>Ethernet communications for the Ethernet 1 port are invalid. The ethernet cable may be disconnected on the port or the ethernet network may be down or experiencing problems.</td>
</tr>
</tbody>
</table>
|                    | No IP Address | The following conditions are occurring:  
• The Method is set to DHCP.  
• The ethernet cable connected to the Ethernet 1 port is connected.  
• A valid IP Address could not be obtained. The DHCP server may be down or is still powering up after a power outage. |
| Current DIP Switch | User Settings | • SW1 is UP and SW2 is UP  
• enables a custom user configuration via DashBoard using the options in the Ethernet tab  
• this is the DIP Switches default setting |
|                   | DHCP      | • SW1 is UP and SW2 is DOWN  
• MC1-PANEL-16 network settings are automatically assigned using DHCP |
|                   | Factory 1 | • SW1 is DOWN and SW2 is UP  
• IP address is set to 192.168.2.10  
• Subnet Mask is set to 255.255.255.0 |
Table 8.4 lists the available options in the Panel Name, Permission tab.

<table>
<thead>
<tr>
<th>Item</th>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Current DIP Switch</td>
<td>Factory 2</td>
<td>• SW1 is <strong>DOWN</strong> and SW2 is <strong>DOWN</strong>&lt;br&gt;• IP address is set to 10.1.2.10&lt;br&gt;• Subnet Mask is set to 255.255.255.0</td>
</tr>
<tr>
<td>Method</td>
<td>Static</td>
<td>User manually supplies the Ethernet settings. This is the recommended setting.</td>
</tr>
<tr>
<td>DHCP*</td>
<td></td>
<td>Automates the assignment of the Ethernet settings</td>
</tr>
<tr>
<td>IP Address</td>
<td>###.###.###</td>
<td>The IP Address for the MC1-PANEL-16</td>
</tr>
<tr>
<td>Subnet Mask</td>
<td>###.###.###</td>
<td>The subnet mask for the MC1-PANEL-16</td>
</tr>
<tr>
<td>Default Gateway</td>
<td>###.###.###</td>
<td>The gateway for communication outside of the local area network (LAN)</td>
</tr>
<tr>
<td>Apply Changes</td>
<td></td>
<td>Applies and saves any changes made to the <strong>Ethernet</strong> settings</td>
</tr>
<tr>
<td>Cancel</td>
<td></td>
<td>Cancels any setting changes and resets the <strong>Ethernet</strong> settings to the previous values</td>
</tr>
</tbody>
</table>

Panel Name, Permission Tab

Table 8.4 lists the available options in the Panel Name, Permission tab.

Table 8.4 Panel Name, Permissions Tab Items

<table>
<thead>
<tr>
<th>Item</th>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Panel Name’s Setting</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Panel Name</td>
<td>#</td>
<td>Specifies the name displayed in DashBoard for this MC1-PANEL-16</td>
</tr>
<tr>
<td>Configuration Lock</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Edit Permission</td>
<td>Unlocked*</td>
<td>All menu items are unlocked and can be edited</td>
</tr>
<tr>
<td></td>
<td>Locked</td>
<td>All menu items, except this one, are locked and read-only. The MC1-PANEL-16 can still be controlled by GPI and/or external device commands if these features were enabled prior to locking.</td>
</tr>
</tbody>
</table>
## Channel, Mnemonic, LCD Tab

Table 8.5 summarizes the options for assigning an MC1-MK card to a channel button on the MC1-PANEL-16 row and the DashBoard interface.

<table>
<thead>
<tr>
<th>Item</th>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Logo</td>
<td>#</td>
<td>Displays the image for the MC1-MK card assigned to the channel</td>
</tr>
<tr>
<td>Channel Name</td>
<td>#</td>
<td>Specifies the name of the channel. This name is displayed in the Active On Air Channel interface, the Channel Select mnemonic button of the MC1-PANEL-16, and the display when the channel is active. There is a 12 character maximum.</td>
</tr>
<tr>
<td>Panel Button Color&lt;sup&gt;a&lt;/sup&gt;</td>
<td>#</td>
<td>Determines the color of buttons on the MC1-PANEL-16 that are not located in the PGM bus. Click Live to preview the color scheme. The dialog stays open. Click OK to apply the color scheme and close the dialog.</td>
</tr>
</tbody>
</table>
| PGM Bus Color<sup>a</sup> | #         | Determines the color of buttons on the MC1-PANEL-16 located in the PGM bus only.  
  - Click Live to preview the color scheme. The dialog stays open.  
  - Click OK to apply the color scheme and close the dialog. |
| On Air Color<sup>b</sup> | #         | Determines the color of buttons for sources currently on-air.  
  - Click Live to preview the color scheme. The dialog stays open.  
  - Click OK to apply the color scheme and close the dialog. |
| On Preset Color<sup>c</sup> | #         | Determines the color of buttons selected for the Preview output.  
  - Click Live to preview the color scheme. The dialog stays open.  
  - Click OK to apply the color scheme and close the dialog. |
| Reset Colors      |           | Resets all the color schemes for the specified channel                      |

### Mnemonic Settings

<table>
<thead>
<tr>
<th>Item</th>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mnemonic Contrast (%)</td>
<td>0-100&lt;sup&gt;d&lt;/sup&gt;</td>
<td>Adjusts the relative display difference between the font and background of all mnemonics</td>
</tr>
</tbody>
</table>
### Alarm Enables Tab

Table 8.6 provides a summary of the options in the **Alarm Enables** tab.

<table>
<thead>
<tr>
<th>Item</th>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PSU Alarm Enable</td>
<td></td>
<td></td>
</tr>
<tr>
<td>PSU# Voltage Out of Range</td>
<td>Selected*</td>
<td>The related PSU Voltage field in the Hardware tab displays a warning when the specified power supply input voltage is &lt;11.5V or &gt;12.5V</td>
</tr>
<tr>
<td></td>
<td>Cleared</td>
<td>The related PSU Voltage field in the Hardware tab ignores the power supply input voltage. Apply to the PSU not being used (in order to disable a false alarm).</td>
</tr>
</tbody>
</table>

### Load/Save Tab

The menu items available in the **Load/Save** tab.

<table>
<thead>
<tr>
<th>Item</th>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Global Settings</td>
<td>Load Factory Defaults</td>
<td>Resets all DashBoard parameters and values (excluding ethernet settings) to the factory default values</td>
</tr>
</tbody>
</table>
Technical Specifications

This chapter includes the input voltages and power consumption for the MC1-PANEL-16.

* Specifications are subject to change without notice.

Environment

Table 9.1  Technical Specifications — Environment

<table>
<thead>
<tr>
<th>Item</th>
<th>Specifications</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operational Temperature Range</td>
<td>0°C - 40°C (32°F - 140°F)</td>
</tr>
</tbody>
</table>

Input Voltage

Table 9.2  Technical Specifications — Input Voltage

<table>
<thead>
<tr>
<th>Item</th>
<th>Specifications</th>
</tr>
</thead>
<tbody>
<tr>
<td>Power Rating</td>
<td>100-120V~</td>
</tr>
<tr>
<td></td>
<td>220-240V~</td>
</tr>
<tr>
<td></td>
<td>47-63Hz</td>
</tr>
</tbody>
</table>

Power

Table 9.3  Technical Specifications — Power

<table>
<thead>
<tr>
<th>Item</th>
<th>Specifications</th>
</tr>
</thead>
<tbody>
<tr>
<td>Power Consumption</td>
<td>&lt;30W</td>
</tr>
</tbody>
</table>
Service Information

Troubleshooting Checklist

Routine maintenance to this openGear product is not required. In the event of problems with your MC1-PANEL-16, the following basic troubleshooting checklist may help identify the source of the problem. If the frame still does not appear to be working properly after checking all possible causes, please contact your openGear products distributor, or the Technical Support department at the numbers listed under the “Contact Us” section.

1. **Visual Review** — Performing a quick visual check may reveal many problems, such as connectors not properly seated or loose cables. Check the MC1-PANEL-16, the openGear frame, and any associated peripheral equipment for signs of trouble.

2. **Power Check** — Verify that the power cable is connected to a power source and that power is available at the power main.

3. **Input Signal Status** — Verify that source equipment is operating correctly and that a valid signal is being supplied.

4. **Output Signal Path** — Verify that destination equipment is operating correctly and receiving a valid signal.

5. **Unit Exchange** — Exchanging a suspect unit with a unit that is known to be working correctly is an efficient method for localizing problems to individual units.

Software Upgrades

If you encounter problems when upgrading your software, verify the following:

- Your network settings on the MC1-PANEL-16 are valid.
- Ethernet communication is properly configured.
- The file you are attempting to load is a *.bin file that is for the MC1-PANEL-16 you are upgrading.

Warranty and Repair Policy

Ross Video Limited (Ross) warrants its switchers and related options, to be free from defects under normal use and service for a period of ONE YEAR from the date of shipment. Fader handle assemblies are warranted for the life of the product. If an item becomes defective within the warranty period Ross will repair or replace the defective item, as determined solely by Ross.

Warranty repairs will be conducted at Ross, with all shipping FOB Ross dock. If repairs are conducted at the customer site, reasonable out-of-pocket charges will apply. At the discretion of Ross, and on a temporary loan basis, plug in circuit boards or other replacement parts may be supplied free of charge while defective items undergo repair. Return packing, shipping, and special handling costs are the responsibility of the customer.

Software upgrades for switchers may occur from time to time, and are determined by Ross Video. The upgrades are posted on the Ross Video website, and are free of charge for the life of the MC1-PANEL-16.

This warranty is void if products are subjected to misuse, neglect, accident, improper installation or application, or unauthorized modification.

In no event shall Ross Video Limited be liable for direct, indirect, special, incidental, or consequential damages (including loss of profit). Implied warranties, including that of merchantability and fitness for a particular purpose, are expressly limited to the duration of this warranty.

This warranty is TRANSFERABLE to subsequent owners, subject to Ross' notification of change of ownership.
Glossary

The following terms are used throughout this guide:

**Active image** — the portion of the video picture area (production aperture) that is being utilized for output content. Active image excludes letterbox bars and pillarbox bars.

**Auto Select Key** — a key in which two video signals are required to insert the key. The Key Alpha is used to cut the hole in the video, and the Key Video is used to fill that hole.

**DashBoard** — the DashBoard Control System.

**DTVCC captions** — CEA-708 captions.

**HTTP** — Direct Hypertext Transfer Protocol.

**LTC** — Linear Timecode.

**MIB** — management information base.

**Mnemonic** — a green, yellow, or orange display used to show the names of a source above or below the source button on the MC1-PANEL-16 chassis.

**NTSC captions** — the CEA-608-D: Line 21 Data Services captions.

**PAL** — PAL-B and PAL-G unless otherwise noted.

**Production aperture** — the image lattice that represents the maximum possible image extent in a given standard (e.g. the full size of all active pixels and active lines). For example, the 1080i production aperture would be 1920x1080.

**Self Key** — a key in which the luminance, or brightness, values of the key source is used as the alpha for the key.

**System** — the mix of interconnected production and terminal equipment in your environment.

**TCP** — Transmission Control Protocol.

**TTL** — Time To Live.

**UDP** — User Datagram Protocol.

**User** — the person who uses the MC1-PANEL-16.

**VGPI** — the Virtual GPI feature of the Miranda™ Presmaster Automation protocol.